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1 Introduction

This topic includes:

§ Welcome To MADRIX HARDWARE MANAGER

§ How To Use This User Manual

§ Topics Of This Chapter

Welcome To MADRIX HARDWARE MANAGER

MADRIX HARDWARE MANAGER allows you to manage compatible MADRIX hardware devices.

Quickly change the main settings of devices or update them to the latest firmware, which is always highly

recommended.

Thank you for choosing MADRIX!

How To Use This User Manual
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§ Press F1 on your keyboard while working with the application to quickly call up the MADRIX HARDWARE

MANAGER User Manual.

§ LINKS are displayed in this color. Simply click through and you will be taken to the corresponding part within the

same topic.

§ »LINKS will take you away from the topic which your are currently reading to another section in this guide or to

an external website.

§ This user guide is written in English.

Important Information

Firmware updates are possible over USB or even via an Art-Net Ethernet network connection:

§ Either use USB or the Ethernet connection!

- When using both connection types devices will be shown with two different entries in the list,

which may lead to severe issues when accidentally updating the device over both connections

simultaneously.

§ Make sure to -stop- sending control data to your devices when managing them with MADRIX

HARDWARE MANAGER.

- This refers to input and/or output over Art-Net, sACN, DMX512, etc.

- Otherwise, changes and updates might fail. If an update fails, stop sending data and try to

update the firmware again.

§ An active internet connection is required to download firmware files. There are no files available

when starting the software for the first time.

Topics Of This Chapter

§ System Requirements

§ Supported Devices

§ Web Links
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1.1 System Requirements

This topic includes:

§ Supported Operating Systems

§ System Requirements

§ General Requirements

Supported Operating Systems

§ Microsoft Windows 10

§ 64 bit only.

§ Please keep the system, drivers, and updates up to date.

System Requirements

§ 2.0 GHz dual-core CPU

§ 2 GB RAM

§ 512 MB free harddisk space

§ 1280 x 768 screen resolution

§ Network card

§ USB 2.0

General Requirements
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§ For the intended purpose of the software, the following is required:

- Devices, i.e. hardware interfaces and controllers, connected over USB or via Ethernet that should

be configured and managed.

- See also »Supported Devices

1.2 Supported Devices

This topic includes:

§ Overview

Overview

MADRIX HARDWARE MANAGER supports hardware products, such as:

§ MADRIX AURA 2

§ MADRIX AURA 8

§ MADRIX AURA 32

§ MADRIX LUNA 4

§ MADRIX LUNA 8

§ MADRIX LUNA 16

§ MADRIX NEBULA

§ MADRIX ORION

§ MADRIX STELLA

Note: MADRIX USB ONE, MADRIX NEO, and MADRIX PLEXUS are not supported.
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1.3 Web Links

This topic includes:

§ Overview

Overview

You can find a selection of useful internet links here:

§ MADRIX Website

»www.madrix.com

§ Drivers

»www.madrix.com/support/download

§ User Guides [Online And Downloadable PDF]

»help.madrix.com

§ Hardware Technical Manuals / Quick Start Guides [Downloadable PDF]

»help.madrix.com

§ Online Forum

»www.madrix.com/support/forum

§ Release Notes

»www.madrix.com/products/software/releases

§ Online Text Tutorials

»help.madrix.com/tutorials/html/index.html

§ Video Tutorials

»https://www.madrix.com/training/video-tutorials

https://www.madrix.com/
https://www.madrix.com/support/download
http://help.madrix.com/
http://help.madrix.com/
https://www.madrix.com/support/forum
https://www.madrix.com/products/software/releases
http://help.madrix.com/tutorials/html/index.html
https://www.madrix.com/training/video-tutorials
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2 Getting Started

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Learn in this chapter how to install and start the MADRIX HARDWARE MANAGER, and more.

Topics Of This Chapter

§ Installation Process

§ Starting The Software

§ About
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2.1 Installation Process

This topic includes:

§ Important Information

§ Using The MADRIX USB Flash Drive

§ Downloading The Software Online

§ Setup Process

§ Uninstallation

§ Software Updates

Important Information 

§ The MADRIX HARDWARE MANAGER can be downloaded from »www.madrix.com. Software updates will be also

released online. 

§ It is highly recommended to always use the latest software update.

Using The MADRIX USB Flash Drive

When using a MADRIX USB flash drive for the installation process, please connect the drive to a free USB port of your

operational computer. The MADRIX HARDWARE MANAGER setup will start automatically using an Auto Installer. Please

wait until the setup has fully loaded. Then, proceed with the Setup Process as described below. When the Auto

Installer does not launch, please navigate to the drive in Windows and manually start the setup process by performing

a double-click on MADRIX_HARDWARE_MANAGER_Install.exe

Downloading The Software Online

§ Download MADRIX_HARDWARE_MANAGER_Install.exe from »www.madrix.com 

https://www.madrix.com
https://www.madrix.com/
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§ After downloading the installer, please double-click with your mouse on this file in order to start the setup

process.

§  Please wait while the Auto Installer is loading the setup. 

§ Afterwards, proceed with the Setup Process as described below.

Setup Process

Please make sure to:

1] If possible, log into Windows as administrator [Admin].

2] Let the computer process the setup. This may take some minutes depending on the speed of your computer.

3] Allow Windows to install all drivers. Windows may ask for your permission to install drivers and expects your

confirmation. Please search for such pop-up windows; they might have opened in the background and might be

covered by other windows.

Step 1]

§ Click Next to start the installation.

§ You can always quit the setup by choosing Cancel

§ Click Back in order to return to a previous step

during the setup process.
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Step 2]

§ The License Agreement will appear. It outlines

the terms you are agreeing to by installing the

software. You must accept these terms in order to

continue.

§ Please click I Agree
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Step 3]

§ This window allows you to select which components

and which drivers you want to install. A description is

given for each item. 

§ MADRIX HARDWARE MANAGER - Is a

required component. It refers to the MADRIX

HARDWARE MANAGER Software.

§ Desktop Shortcut - Select if you wish to create a

shortcut to the software on your Windows desktop.

By default, the component is selected.

§ Quick Launch Shortcut - Select if you wish to

create a shortcut to the software in your Windows

taskbar. By default, the component is not selected.

§ MADRIX KEY Driver - Is a required component.

It is normally required by all MADRIX software

products and possibly by other applications.

§ Interface Drivers - Select if you wish to install

the drivers for supported MADRIX hardware

interfaces. By default, the component is selected.

[You may not need to do this again, since you may

already have them installed via MADRIX 5 Software,

for example.]

[The interface drivers are required for the

connection over USB.]

§ Next - Click Next after choosing the components in

order to continue.
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Step 4]

§ Choose an installation directory on your hard drive

where the software will be installed. A default

Destination Folder will automatically be provided

by the setup. 

§ Browse... - Click to change the folder.

§ Install - Click to start the installation process.

Step 5]

§ The installation process may take a few minutes.

§ Installation Complete - Click Next when this

message shown.

Step 6]

§ Run MADRIX HARDWARE MANAGER -

Deselect if you do not wish to start the software

now. 

§ Finish - Click to quit the setup.
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Uninstallation

Step 1]

§ Click Next to start the uninstallation.

§ You can always quit the uninstaller by choosing

Cancel

§ Click Back in order to return to a previous step

during the process.
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Step 2]

§ This window allows you to select which components

and which drivers you want to uninstall. A description

is given for each item. 

§ MADRIX HARDWARE MANAGER - Is a

required component. It refers to the MADRIX

HARDWARE MANAGER Software.

§ Log Files - Select if you wish to remove all files

saved for logging. By default, the component is

selected.

§ Documents - Select if you wish to remove all

documentation files saved for each hardware

interface. By default, the component is not selected.

§ MADRIX KEY Driver - Select if you wish to

uninstall the MADRIX KEY driver. It is normally

required by all MADRIX software products and

possibly by other applications. By default, the

component is not selected.

[Only remove it if no other software, such as

MADRIX 5 or MADRIX RADAR, requires the

driver. If you have such software installed and

are using it, do not remove it!]

§ Interface Drivers - Select if you wish to uninstall

the drivers of the MADRIX hardware interfaces. By

default, the component is not selected.

[Only remove them if no other software, such

as MADRIX 5, requires the drivers. If you have

such software installed and are using it, do not

remove them!]
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§ Uninstall - Click Uninstall after choosing the

components in order to continue.

Step 3]

§ The uninstallation process may take a short while.

§ Uninstallation Complete - Click Close when

this message shown.

Software Updates

Checking For New Software Versions

It is always recommended to run the latest software version. MADRIX HARDWARE MANAGER automatically searches

for updates at startup.

§ By default, the option is enabled. To change it, select the menu Preferences > Options... > Startup >

Check For Software Updates

§ To manually search for an update, select the menu Help > Check For Software Updates...

§ Choose Skip This Version if you would like to skip a particular version.
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Installing New Software Versions

When a new software version has been released, please update your current MADRIX HARDWARE MANAGER

installation to the newest version.

§ Check and download the latest MADRIX HARDWARE MANAGER as described above.

§ You can also directly download it from »www.madrix.com 

§ It is not required to uninstall MADRIX HARDWARE MANAGER before you install a new software version.

§ Instead, follow the process described under Downloading The Software Online 

§ The installer will ask you if you would like to update your current software installation. Confirm with Yes

https://www.madrix.com/
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2.2 Starting The Software

This topic includes:

§ Introduction

§ Desktop Shortcut

§ Windows Start Menu

Introduction

You can start MADRIX HARDWARE MANAGER in different ways. Among those, the Windows Start Menu is the standard

way to launch applications under the Windows operating system.

Desktop Shortcut

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on the desktop shortcut in

order to start the MADRIX HARDWARE MANAGER.

- It is required that the shortcut has been manually placed on the Desktop or was automatically installed during

the »Installation Process

Windows Start Menu

§ In Windows, go to Start > MADRIX HARDWARE MANAGER > MADRIX HARDWARE MANAGER

- The MADRIX HARDWARE MANAGER will start.
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In addition, the Start Menu contains the following main items:

§ Help MADRIX HARDWARE MANAGER

§ MADRIX HARDWARE MANAGER Quick Support
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2.3 About

This topic includes:

§ Introduction

§ Overview

Introduction

The About window provides a quick overview over software details and legal information.

§ Go to the menu Help > About...

Overview
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Software

Version Shows which software version you are currently running and using. It also shows the

used software architecture: MADRIX HARDWARE MANAGER is 64-bit only.

Build Shows when the current software version was created.

Legal Copyright © 2021 - 2022 inoage GmbH. All rights reserved. See »Imprint And Copyright

End-User License

Agreement

Legal Information - Opens this user guide, which includes the End-User License

Agreement. See »End-User License Agreement [EULA]

Third Parties

Qt About Qt - Shows more information about the Qt development framework.

License - Shows the license under which Qt is used.

OpenSSL License - Shows the licenses under which OpenSSL is used.

Sourcetree Is a Git client program used for development with thanks. Powered by Atlassian. 

Miscellaneous
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Left Mouse Click + Hold + Select / Left Mouse

Double-Click / Left Mouse Triple-Click - Allows you to

select text.

Right Mouse Click > Copy - Allows you to copy text in order

to paste the information into an e-mail, for example.

Right Mouse Click > Select All - Selects all text of the

currently selected row.

Check For Software Updates Checks online if a software update is available for downloading.

This requires an active internet connection.

Close Closes the About window.
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3 Using The Software

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

MADRIX HARDWARE MANAGER allows you to conveniently manage different devices with one software. The following

chapters will explain how to work with the software in more detail.

Topics Of This Chapter

§ Menu

§ Devices [View]

§ Firmware Files [View]

§ External Storage [View]

§ Updating Firmwares

§ Options

§ Log

§ User Interface
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3.1 Menu

This topic includes:

§ Introduction

§ Extra Information Displayed

§ File Menu

§ View Menu

§ Preferences Menu

§ Devices Menu

§ Firmware Files Menu

§ Help Menu

Introduction

The main menu of this software is located at the top of the application window.

Extra Information Displayed

Ctrl + T - This represents a keyboard shortcut that will perform the action directly rather than using the menu.

... - Indicates that a new window will open on top of the main software window.

> - Indicates that this entry has sub-entries.

File Menu
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§ Quit - Closes the software.

View Menu

Refers to how the user interface looks.

§ Theme > Light - Activates the user interface theme that is light in color.

§ Theme > Dark - Activates the user interface theme that is darker in color.

§ Log - Shows or hides the separate Log view. Learn more »Log 

§ Restore Default Window Layout - Applies the default settings for the graphical user interface, including

sizes, layout, and default table columns. As such, it resets any changes in size you made to the software

window.

Preferences Menu

These settings remain valid and set beyond any restart of the software.
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§ Options ... - Allows you to configure various important settings for the software. Learn more »Options 

Devices Menu

Refers to tools that allow configuration of devices or communication with them in the network.

§ Discover Devices - Manually performs a scan for all available hardware interfaces in the network in order to

find and add them to the list of devices. [USB devices do not require such a scan.]

Learn more »Devices

Firmware Files Menu

Refers to working with firmware files for the devices.
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§ Import Files... - Allows you to manually bring firmware files and bootloader files into the local directories of

MADRIX HARDWARE MANAGER [in *.fwx file format].

- First, a new window opens that allows you to choose the files from the file system. They will be copied from

the source then. Afterwards, the firmwares are available in the Firmware Files tab.

- The software uses <User Directory>\Documents\MADRIX HARDWARE MANAGER\cache\firmware\ to store the

files.

- Learn more »Firmware Files

§ Download Latest Firmware File For Each Product - Manually starts the process to download the

newest firmware versions for all supported devices if new versions are available.

- Please note that this does not include any bootloader versions that may be required first to run the firmware on

the device. It also does not automatically update any devices. 

Learn more »Firmware Files

Help Menu

§ User Manual... - Opens this user guide, locally on your computer using your default web browser.

§ User Manual Online - Opens this user guide online by calling up a website using your default web browser.

This requires an internet connection.
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§ Forum - Is an online link that will take you to the MADRIX Online Forum, where users and developers can

exchange ideas about MADRIX HARDWARE MANAGER. This requires an internet connection.

§ Feedback - Is an online link that will open your web browser with the MADRIX Contact Form. If you wish,

please enter your comments into the form and send it to us. Thank you! This requires an internet connection.

§ Website - Is an online link for the MADRIX website »www.madrix.com. This requires an internet connection.

§ Launch Remote Support Tool... - Opens the external support tool provided with MADRIX HARDWARE

MANAGER. This requires an internet connection. MADRIX technical support team may request that you launch

this tool for further assistance.

§ Check For Software Updates... - Checks online if a software update is available for downloading. This

requires an internet connection.

§ About... - Provides information about MADRIX HARDWARE MANAGER and legal information.

http://www.madrix.com
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3.2 Devices [View]

This topic includes:

§ Introduction

§ Connecting Your Devices

§ List Of Devices

§ Editing And Changing Values

§ Context-Menu

§ Search

§ Customization

Introduction

The list of devices shows all connected hardware interfaces and their main information and settings in a list.
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Connecting Your Devices

1] Physical Connection

§ Connect your devices over USB or via an Ethernet network connection to the computer that is running the

MADRIX HARDWARE MANAGER.

- See the Technical Manuals of each device for more information on how to properly connect them.

- Either use USB or the Ethernet connection!

- When using both connection types devices will be shown with two different entries in the list,

which may lead to severe issues when accidentally updating the device over both connections

simultaneously.

- Either use the connection over USB, and make sure to disconnect the network cables. Or use the network

connection and for corresponding devices use an external power supply, such as a USB power supply.

Connect only over USB or only via Ethernet. Do not connect devices using both USB and Ethernet!

2] Device Discovery

§ MADRIX HARDWARE MANAGER automatically tracks the connection to your devices, especially when it comes to

USB. New connections or disconnects over USB should be registered immediately.

§ Regarding Ethernet, polls are sent out to devices every 30 seconds. New connections should be registered within

1 minute. Disconnects are registered within 1 to 2 minutes. You can manually start the discovery process to

search for network devices via menu Devices > Discover Devices

3] Device Management

§ After successfully establishing a connection to your devices, you can manage them using the list of devices as

explained below.

§ Make sure to -stop- sending control data to your devices when managing them with MADRIX

HARDWARE MANAGER.

- This refers to input and/or output over Art-Net, sACN, DMX512, etc.

- Otherwise, changes and updates might fail. If an update fails, stop sending data and try to

update the firmware again.
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List Of Devices

By default, the following information regarding connected devices is provided since the following columns are enabled

in the list.

Note: Certain information may not be available for all devices at all times. Then, <Not Available> will be shown

accordingly.

Connection Type Shows how devices are connected.

Devices can be connected over USB, Art-Net [Ethernet] and/or MadrixN

[Ethernet].

Interface drivers are required for the connection over USB. See »Installation

Process

Connect either over USB or Ethernet, but not both!

Name Shows the description of the devices. Corresponds to the Name that can be set using

the web configuration or the Art-Net Long Name.

You can change this setting. See below.

Example: MADRIX STELLA Unit 2

Product Shows the official name of the connected device [product/model].

Example: MADRIX NEBULA

Serial Number Shows the unique numerical identifier of the device. May not be available for devices

connected only over Art-Net.

Example: NEBULA000664



[Part C] Using The Software

//36www.madrix.com

MADRIX HARDWARE MANAGER User Manual 1.0.

IP Address Shows the currently set IPv4 network address, which is part of the basic network

settings.

Is an identifier for devices that enables network communication. When using network

protocols, it needs to be unique and set up for each individual sender or recipient in the

network.

You can change this setting. See below.

A new window will open to be able to change IP Address, Subnet Mask, and Gateway.

Make sure to use correct settings. Changing the IP address without entering the correct

and corresponding subnet mask can lead to the device not being accessible anymore,

which then usually requires a reset to manufacturer default settings.

Example: 10.77.66.152

Subnet Mask Shows the currently set network mask, which is part of the basic network settings.

Is a technical grouping mechanism for network devices. When using network protocols,

it needs to be set up for each sender or recipient in the network for correct data

routing.

[Please note: Your devices and the sender, such as the PC that runs MADRIX 5, need

to have the same subnet mask!]

You can change this setting. See below.

A new window will open to be able to change IP Address, Subnet Mask, and Gateway.

Make sure to use correct settings. Changing the IP address without entering the correct

and corresponding subnet mask can lead to the device not being accessible anymore,

which then usually requires a reset to manufacturer default settings.

Example: 255.0.0.0
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Gateway Shows the currently set network gateway.

Is a technical routing mechanism for Ethernet networks, which acts as the main

receiver in case the original network recipients are not available anymore. When using

network protocols, it needs to be in the same network as the IP address and in this

way set up correctly for network communication to work.

You can change this setting. See below.

A new window will open to be able to change IP Address, Subnet Mask, and Gateway.

Make sure to use correct settings. Changing the IP address without entering the correct

and corresponding subnet mask can lead to the device not being accessible anymore,

which then usually requires a reset to manufacturer default settings.

Example: 10.0.0.1

MAC Address Shows the Media-Access-Control address of the device, which is used as unique

identifier in networks. Is always available for devices connected via Art-Net or MadrixN.

May not be available for devices connected over USB.

Example: CC:00:DD:00:CC:00

Identify Allows you to choose/activate the built-in identification mode of the device. May not be

retrievable as information for devices connected over USB using older firmware

versions, but it should still be possible to set it.

You can change this setting. See below.

No deactivates identification. Yes activates identification.

Date - Time Shows the currently set date and time [YYYY/MM/DD - HH:MM:SS].

If Daylight-Saving-Time is activated on the computer that runs MADRIX HARDWARE

MANAGER, DST is also enabled on the device itself.

Is being updated nearly every second when connected over USB. Is being updated

every 30s when connected via Ethernet.

You can change this setting. See below.

Example: 2021/08/17 - 10:52:58
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Location Shows the currently set location of the device [N/S d°m°s", E/W ddd°m's"].

You can change this setting. See below.

Values can be entered as:

- N 41° 13' 37", E 013° 44' 0" or as variants thereof N 41° 13' E 12°33',

- Floating-point values 0.233 0.133, which will be converted automatically into the

sexagesimal format,

- City; using the built-in auto-complete.

Example: N 51° 2' 5", E 013° 45' 7"
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Firmware Shows the currently used firmware version. The firmware provides the software

features of the device.

May show a green icon [that is, a gear wheel with an arrow] if a newer firmware

version is available for the device.

It is always recommended to use the latest version.

You can change this setting. See below. This means you can initiate an update to a

different firmware version here directly.

Example: 2.06.7355

§ Only devices which meet all requirements will be updated.

- The requirements are listed in the »Firmware Files [View]

§ Firmware updates might reset the device settings. / Firmware

downgrades always require the device settings to be reset.

- Make a backup of the configuration and files before updating (or

downgrading) the firmware of your devices!

- New firmware versions may introduce new features, which requires a

reset of all parameters. Downgrades to older firmware versions require

a full reset to factory default settings to restore full functionality.

- MADRIX LUNA, NEBULA, ORION, STELLA:

Device settings are available in the web configuration. Write down its

settings or make a full-page screenshot, for example.

- MADRIX AURA:

Scenes are saved on the SD card. ShowConfig.xml is saved on the SD

card [includes Cue List, Timers]. ChannelConfig.xml is saved on the SD

card if it has been created [includes Channel Mask configuration].

NetConfig.xml can be saved on the SD card by executing the backup

function under Settings > Backup [includes Recording, Playback, and

Remote Control]. Device Settings are only available in the web

configuration. Write down its settings or make a full-page screenshot,

for example.

Learn more »Firmware Updates
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Bootloader Shows the currently used bootloader version. The bootloader is a subsystem of the

device's software that manages the underlying functionality of components and

launches the firmware. Certain firmware versions may require a specific bootloader

version.

If connected over USB, the device might need to switch into the bootloader, which

might trigger a reconnect of the device.

If connected via Art-Net, the device needs to be in bootloader mode in order to retrieve

the bootloader version, which then requires a firmware to be uploaded. That is why,

the bootloader is usually not available via Art-Net. The bootloader version can also not

be retrieved via MadrixN.

Example: 2.00.7095

HW Revision Short for Hardware Revision. Shows the edition/revision of the connected hardware

interface.

Example: 1.0

Editing And Changing Values

Overview

§ In general, this list shows information provided by the devices.

§ In certain cases, the edit icon [that is, a pen] shows that the respective information/column can be edited by

you.

Single Edits

§ Left Mouse Click - Allows you to select a single cell.

§ Left Mouse Double-Click - Perform a double-click with your left mouse button on a value in order to edit it.

[Keyboard shortcut: F2]
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§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.

You may be presented with different choices.

You may be able to directly enter numbers or text as input.

Multi-Edits

§ Ctrl + Left Mouse Click or Shift + Left Mouse Click + Select First List Entry + Select Last List

Entry - Allows you to select multiple items in a column in the list.

§ Ctrl + A - Selects all devices in the list.

§ F2 - Activates the edit mode for multiple devices at once. Select multiple devices first.

§ Confirm with Enter [or click outside of the currently active cell with the mouse]. Abort any changes with

Escape.

§ Please note that different devices may support different values.
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Visual Feedback For Edits

The software will show you if any changes you have made are set successfully or not. This status is shown for a

couple of seconds after each change.

Green - The changes were successfully set.

Yellow - The request is currently pending.

Red - The new value could not be set.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on a device.

Edit Allows you to change the entry [if it can be edited].

[Keyboard shortcut: F2]
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Open Device

Configuration Via

HTTP...

Opens the website configuration of the device using its IP address via the default web

browser on your computer.

If the web configuration cannot be opened, the network might not be reachable over

HTTP or the device might be restarting.

This requires an Ethernet network connection to the device.

Show Documentation

Directory...

Opens the folder on your PC/file system with the latest documentation files for this

device type, such as Technical Manual, Datasheet, and User Manual.

New documents or updated documents will be automatically downloaded. Files that

are not fully downloaded yet are named *.tmp until completed. Outdated documents

will be removed.

This requires an active internet connection.

Restore Factory

Default Settings

Restores the original settings of the device. 

Please allow some time for the process to take effect.

Copy Cell To Clipboard Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all device information] into the

clipboard/temporary memory. If several lines are selected, the header of the column

will be copied as well. Content is divided by single spaces.

[Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search
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§ Search - Enter any text in order to search all devices in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:]. Only columns that are currently shown and visible can be

searched this way.

- For example: Prod:AUR shows all lines where a MADRIX AURA hardware interface is connected by

referencing the column Product for example. If no column is shown that includes 'Prod', MADRIX HARDWARE

MANAGER will search all shown columns for the specifically entered term.

- You may execute RegEx searches [regular expression] by prefixing search terms via /r

Customization

MADRIX HARDWARE MANAGER allows you to choose which parameters are presented in this view. You can decide

which columns are hidden or shown.
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§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Connection Type Shows or hides the Connection Type column.

Name Shows or hides the Name column.

Product Shows or hides the Product column.

Serial Number Shows or hides the Serial Number column.

IP Address Shows or hides the IP Address column.

Subnet Mask Shows or hides the Subnet Mask column.
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Gateway Shows or hides the Gateway column.

MAC Address Shows or hides the MAC Address column.

Identify Shows or hides the Identify column.

Date - Time Shows or hides the Date - Time column.

Location Shows or hides the Location column.

Firmware Shows or hides the Firmware column.

Bootloader Shows or hides the Bootloader column.

HW Revision Shows or hides the HW Revision column [Hardware Revision].

For example, if you wish to sort via Product, make sure to activate column Product and click on the corresponding

header to sort in ascending or descending order.
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3.3 Firmware Files [View]

This topic includes:

§ Introduction

§ Overview

§ Context-Menus

§ Search

Introduction

The list of firmware files shows all available firmware versions and bootloader versions for supported devices in a list.

- This requires an active internet connection.

- Files that have been imported manually via the menu without an internet connection will also be shown here. See

»Menu

- See »Firmware Updates to learn how to install firmwares on your devices.

You can manage these files here, including download and deletion.
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An active internet connection is required to download firmware files. There are no files available when

starting the software for the first time.

Overview

By default, the following information regarding files is provided since the following columns are enabled in the list:

Product Lists all supported devices.

> Allows you to show all files for this kind of device by expanding the list. [You can

collapse the list again vice versa.] 

Status Shows the current state of the file.

OK - The file has been fully downloaded or imported and is available locally.

Available - The file is available online and can be downloaded from the web server.

Downloading... - The file is currently being downloaded from the web server.

Corrupt - The file has been downloaded, but seems to be faulty. You should delete it

and then download it again [Right Mouse Click > Delete & Right Mouse Click

> Download]. 

Type Shows the file type, which is either a Firmware file or a Bootloader file.

Version Shows the firmware version or bootloader version; depending on the type.

Files in the list are sorted in descending order according to their version number. You

can find the latest firmware files at the top.

Release Date Shows when the firmware or bootloader was released.

Size Shows the file size [in B, KiB, MiB, GiB, or TiB].
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Required Firmware Shows if a file requires a specific firmware version, which should be uploaded to the

device first.

> means that the version needs to be greater than the specified version.

< means that the version needs to be less than the specified version

= means that the version needs to be greater than the specified version or exactly the

specified version

= means that the version needs to be less than the specified version or exactly the

specified version

Required Bootloader Shows if a file requires a specific bootloader version, which should be uploaded to the

device first.

> means that the version needs to be greater than the specified version.

< means that the version needs to be less than the specified version

= means that the version needs to be greater than the specified version or exactly the

specified version

= means that the version needs to be less than the specified version or exactly the

specified version

Required HW

Revision

Shows if a file requires a specific hardware revision.

> means that the hardware revision needs to be greater than the specified hardware

revision.

< means that the hardware revision needs to be less than the specified hardware

revision

= means that the hardware revision needs to be greater than the specified hardware

revision or exactly the specified hardware revision

= means that the hardware revision needs to be less than the specified hardware

revision or exactly the specified hardware revision

Required Connection

Type

Shows the types of connections that can be used to install the specific firmware [Art-

Net, USB].

Certain firmware versions may only be possible over one connection type, such as USB.



[Part C] Using The Software

//50www.madrix.com

MADRIX HARDWARE MANAGER User Manual 1.0.

Factory Reset Shows if the software performs a reset to manufacturer default settings after installing

the specific firmware [After Downgrade, Always]. 

Resets are always required after downgrading the firmware and may be always

required, meaning after downgrades and after updates.

Notes Shows if a firmware has been imported manually and is thus only available locally.

Note: When deleting manually imported files, they cannot simply be downloaded again

since they are only available locally.

Context-Menus

Device Types

§ Right Mouse Click - Perform a click with your right mouse button on a single or multiple device types in the

list.
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Download Latest

Firmware Files

Allows you to download the newest file, which is then saved locally on your computer

system. This requires an active internet connection.

Files are stored in <User Directory>\Documents\MADRIX HARDWARE

MANAGER\cache\firmware

This does not automatically download the specific bootloader version, which may be

required.

Download All Files Allows you to download all available firmware files and bootloader files, which are

then saved locally on your computer system. This requires an active internet

connection.

Files are stored in <User Directory>\Documents\MADRIX HARDWARE

MANAGER\cache\firmware

Delete All Files Allows you to delete all firmware files and bootloader files, which are already saved

locally.

Note: When deleting manually imported files, they are only available locally and

cannot simply be downloaded again.

[Keyboard shortcut: Del]

Show Release Notes... Opens a website showing the changes for every firmware version via the default web

browser on your computer. This requires an active internet connection.

Copy Cell To Clipboard Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all device information] into the

clipboard/temporary memory. If several lines are selected, the header of the column

will be copied as well. Content is divided by single spaces.

[Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.
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Files

§ Right Mouse Click - Perform a click with your right mouse button on one or more files in the list.

Download Allows you to download the currently selected files, which are then saved locally on

your computer system. This requires an active internet connection.

Files are stored in <User Directory>\Documents\MADRIX HARDWARE

MANAGER\cache\firmware

Delete Allows you to delete the currently selected files, which are already saved locally.

Note: When deleting manually imported files, they are only available locally and

cannot simply be downloaded again.

[Keyboard shortcut: Del]

Show Release Notes... Opens a website showing the changes for every firmware version via the default web

browser on your computer. This requires an active internet connection.

Copy Cell To Clipboard Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all device information] into the

clipboard/temporary memory. If several lines are selected, the header of the column

will be copied as well. Content is divided by single spaces.

[Keyboard shortcut: Ctrl + Shift + C]
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Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all devices in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:]. Only columns that are currently shown and visible can be

searched this way.

- For example: Prod:AUR shows all lines where a MADRIX AURA hardware interface is connected by

referencing the column Product for example. If no column is shown that includes 'Prod', MADRIX HARDWARE

MANAGER will search all shown columns for the specifically entered term.

- You may execute RegEx searches by prefixing search terms via /r
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3.4 External Storage [View]

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Visual Feedback For Edits

§ Drag & Drop

§ Search

Introduction

The External Storage view allows you to manage files on devices that offer storage as part of their feature set, mainly

MADRIX AURA.

Devices can either be connected over USB or via MadrixN over Ethernet network.
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Overview

By default, the following information regarding external storage is provided since the following columns are enabled in

the list:

Name Shows the name of devices [Name plus MAC Address and Serial Number; for

better identification], directories, and files [including file format].

> Allows you to show all files for this kind of device by expanding the list. [You can

collapse the list again vice versa.]

Hidden files will also be shown.

Last Modification Shows when the files was changed the last time [YYYY/MM/DD HH:MM:SS].

Type Shows the kind of the list item [File, File (Read Only), Directory, Directory

(Read Only)].

Also shows for each device any special status of the SD Card [Pending while reading

the information, No SD Card if no memory card is inserted into the device or

available, Read-Only if the SD card is write-protected].

Size Shows the size of files [in B, KiB, MiB, GiB, or TiB].

Also shows for each device the size of the SD card and any free space, such as 7.48

GiB free of 7.53 GiB for example.

Context-Menu
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§ Right Mouse Click - Perform a click with your right mouse button on a device, a directory, or a file.

Open Device

Configuration Via

HTTP...

Opens the website configuration of the device using its IP address via the default web

browser on your computer.

If the web configuration cannot be opened, the network might not be reachable over

HTTP or the device might be restarting.

This requires an Ethernet network connection to the device.

Reload Configuration Is only available if devices are selected.

Allows you to manually make the device reload the main configuration file again.

- It is necessary for you to execute this functionality if a configuration file

[ShowConfig.xml] has been uploaded before all scene files were uploaded

and available on the storage.

- Is automatically performed by MADRIX HARDWARE MANAGER if a configuration file

[ShowConfig.xml] or scene files [of the *.dxd file format] have been uploaded.

Format External

Storage

Is only available if devices are selected.

Deletes and erases all files from the external storage [such as SD cards] by setting

up the file system anew.
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Refresh Is only available if devices or directories are selected.

Updates the contents of the selected devices or directories and makes therefore sure

that the latest data is shown in the list.

Create Directory... Is only available if a single device or single directory is selected.

Creates a new directory on the external storage [when executed in a context menu

that has been called by selecting a device] or creates a subfolder [when executed in

a context menu that has been called by selecting a directory]. You can then choose

and enter a name for the new directory.

Upload Files... Is only available if a single device or single directory is selected. Is not available when

having selected multiple devices in the list. 

Opens a file dialog to choose the files that should be uploaded to the device from the

file system of your computer.

- If there are already files available on the external storage with the same name, the

software will add numbers to the file names of the new files accordingly [02, 03,

etc.].

- Uploads the files into the selected directory if a directory has been selected.

- Deleting a file from the list will cancel the file upload if the file was not yet fully

uploaded.

Please note:

§ MADRIX AURA Scene Files are required in *.dxd file format.

§ NetConfig.xml is a mandatory file of MADRIX AURA that contains the device

configuration. Do not attempt any changes! [If needed, NetConfig.bak is the

corresponding backup file.]

§ ShowConfig.xml is a mandatory file of MADRIX AURA that contains the

show configuration. Do not attempt any changes! [If needed, ShowConfig.bak is

the corresponding backup file.]

§ logfile.txt is a file to log events.
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Download Files... Opens a file dialog to choose the folder to where files should be downloaded to the

file system of your computer. Downloads all files if a device has been selected.

Downloads the selected files if multiple files have been selected.

- If there are already files available in the download folder, the software will add

numbers to the file names of the new files accordingly [02, 03, etc.].

- Any folder structure on the external storage will also be copied to the download

folder.

Delete Is only available if directories or files are selected. Erases the selected files [if not set

to read only] or erases entire directories and their contents [if possible].

[Keyboard shortcut: Del]

- Deleting a file from the list will cancel the file upload if the file was not yet fully

uploaded.

Copy Cell To Clipboard Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all device information] into the

clipboard/temporary memory. If several lines are selected, the header of the column

will be copied as well. Content is divided by single spaces.

[Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Visual Feedback For Edits

The software will show you if any changes you have made have been set successfully or not. This status is shown for

a couple of seconds after each change.
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Green - The actions were successful.

Yellow - The request is currently pending.

Red - The actions were not successful.

Drag & Drop

In addition to using the context menu as explained above, you may use drag and drop to copy files from the file system

of your computer to the external storage of a device.

[Copying files from the external storage to your computer via drag and drop is not possible.]

MADRIX AURA Scene Files are required in *.dxd file format.
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Search
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§ Search - Enter any text in order to search all devices in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:]. Only columns that are currently shown and visible can be

searched this way.

- For example: Prod:AUR shows all lines where a MADRIX AURA hardware interface is connected by

referencing the column Product for example. If no column is shown that includes 'Prod', MADRIX HARDWARE

MANAGER will search all shown columns for the specifically entered term.

- You may execute RegEx searches [regular expression] by prefixing search terms via /r
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3.5 Updating Firmwares

This topic includes:

§ Overview

§ 1] Firmware Files

§ 2] Connect Your Devices

§ 3] Device Selection

§ 4] Firmware Selection

§ 5] Confirmation

Overview

As a short reference, the steps to update the firmware of devices are laid out in this chapter.

The firmware provides the software features of the device. It is always recommended to use the latest

firmware.

Important Information

Firmware updates are possible over USB or even via an Art-Net Ethernet network connection:

§ Either use USB or the Ethernet connection!

- When using both connection types devices will be shown with two different entries in the list,

which may lead to severe issues when accidentally updating the device over both connections

simultaneously.

§ Make sure to -stop- sending control data to your devices when managing them with MADRIX

HARDWARE MANAGER.

- This refers to input and/or output over Art-Net, sACN, DMX512, etc.

- Otherwise, changes and updates might fail. If an update fails, stop sending data and try to

update the firmware again.
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§ An active internet connection is required to download firmware files. There are no files available

when starting the software for the first time.

§ Only devices which meet all requirements will be updated.

- The requirements are listed in the »Firmware Files [View]

§ Firmware updates might reset the device settings. / Firmware downgrades always require the

device settings to be reset.

- Make a backup of the configuration and files before updating (or downgrading) the firmware of

your devices!

- New firmware versions may introduce new features, which requires a reset of all parameters.

Downgrades to older firmware versions require a full reset to factory default settings to restore

full functionality.

- MADRIX LUNA, NEBULA, ORION, STELLA:

Device settings are available in the web configuration. Write down its settings or make a full-page

screenshot, for example.

- MADRIX AURA:

Scenes are saved on the SD card. ShowConfig.xml is saved on the SD card [includes Cue List,

Timers]. ChannelConfig.xml is saved on the SD card if it has been created [includes Channel Mask

configuration]. NetConfig.xml can be saved on the SD card by executing the backup function under

Settings > Backup [includes Recording, Playback, and Remote Control]. Device Settings are only

available in the web configuration. Write down its settings or make a full-page screenshot, for

example.

§ Devices that are daisy-chained should not be updated at the same time!

- Reason: Restarting devices along the chain cut off communication between software and the rest

of the devices, which can lead to devices being in unknown states.

- Instead, perform the firmware update individually for each device.

1] Firmware Files

§ Make sure to download and have available or the firmware files you require.

See »Firmware Files [View]



[Part C] Using The Software

//64www.madrix.com

MADRIX HARDWARE MANAGER User Manual 1.0.

§ Needed only in rare cases, it is also possible to manually import firmware files and bootloader files.

See »Menu

§ By default, MADRIX HARDWARE MANAGER downloads the latest firmware files automatically.

See »Options

2] Connect Your Devices

§ Connect your devices. 

See »Devices [View]

3] Device Selection

§ Select your device in the list of devices.

Then, navigate to view Devices > column Firmware

See »Devices [View]

4] Firmware Selection

§ Under view Devices > column Firmware choose your firmware version via F2 or Right Mouse Click >

Edit or Left Mouse Double-Click

- All firmware versions that are available locally are available for selection [files in the Firmware Files view with

status OK].

- The software may show a green icon [that is, a gear wheel with an arrow] if a newer firmware version is

available for the device.

- Confirm with keyboard shortcut Enter or click away with the mouse.
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5] Confirmation

§ Confirm that you wish to update the firmware of your device via Yes. Abort the process via No.

§ Please note:
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- MADRIX HARDWARE MANAGER will check if the requirements are met by the selected devices to update the

firmware. First, a required bootloader may be uploaded to the device in the process.

- The update process might take a short while. Please allow a few minutes for the process to complete in case of

Art-Net. Updates over USB are usually completed relatively quickly.

- Art-Net: If the update fails during the process, MADRIX HARDWARE MANAGER will try again several times to

update the firmware of devices. Once successful, the device will be restarted.

- USB: If the update fails during the process, MADRIX HARDWARE MANAGER will try again several times to update

the firmware of devices.

- During the update process, the software will show the progress in percent [%] under view Devices > column

Firmware or view Devices > column Bootloader

- If the update was successful or if errors occur during the update process, the information will be written to the

Log. See »Log

- If the update process is unsuccessful, devices might be in a bootloader state and/or unresponsive. If so, see the

correlating Technical Manual on how to proceed.

- You may choose not only to update but also to downgrade the firmware and bootloader. In both cases a reset to

factory default settings will automatically be executed afterwards by the software as indicated on the user

interface.
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3.6 Options

This topic includes:

§ Overview

§ Startup

§ Logging

§ Notes

Overview

MADRIX HARDWARE MANAGER allows you to set up optional settings which remain valid and set beyond any restart of

the software.

Startup

The following options refer to the initiation of the software.

§ Go to the menu Preferences > Options... > Startup

[Keyboard shortcut: Ctrl + Alt + O > Startup]

§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.
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§ Enable System Proxy - Uses the system proxy. 

- A proxy is an optional intermediary for the client-server communication in a network.

- If you have set up and are using a system-wide proxy in the Windows operating system, enable this option here

in order to let MADRIX HARDWARE MANAGER route its network data through it.

- Leave this setting disabled if you are not using a system proxy or are unsure.

[This option is set to Off by default.]

§ Check For Software Updates - Automatically searches for software updates. When a new update is

available, a notification will be presented to you when starting the software. This requires an active internet

connection.

[This option is set to On by default.]

§ Download Latest Firmware File For Each Product Automatically - For your convenience, MADRIX

HARDWARE MANAGER automatically downloads the newest firmware version for each supported product during

startup. This requires an active internet connection. See also »Menu

[This option is set to On by default.]

Logging

The following options refer to the automatic logging process of the software.

§ Go to the menu Preferences > Options... > Logging

[Keyboard shortcut: Ctrl + Alt + O > Logging]
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§ Restore the default settings via Defaults.

§ Confirm any changes with OK or Apply. Discard any changes via Cancel.

§ Directory - Defines the location on your computer, where log files are saved. 

- Browse... - Allows you to choose a different folder or directory.

§ Retention Time - Defines the time interval after which log files are deleted from the computer. Enter any

number and choose between Hours, Days, and Weeks.

[The default value for this option is 365 days.]

[The maximum is 1679832 Hours, 69993 Days, or 9999 Weeks.]

Notes

All settings are saved locally on your computer.
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3.7 Log

This topic includes:

§ Introduction

§ Overview

§ Context-Menu

§ Search

§ Options

§ Customization

Introduction

The Log view shows all important occurrences for the MADRIX HARDWARE MANAGER itself and its communication with

devices. 

Such logging and subsequent files are very helpful for technical support and assistance, but aren't necessarily required

for the general use of the software. Still, it can provide you with valuable information and feedback for

troubleshooting.

§ By default, the log view is hidden. 

§ To show it, enable it in the menu View > Log
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Overview

§ Severity - Allows you to filter only for specific kinds of information [including Info, Warning, Critical,

Fatal]. 

- A specific severity level includes information for its own level as well as all higher levels. 

By default, the following information is provided since the following columns are enabled in the list:

Timestamp Shows the local time when the status message occurred [YYYY/MM/DD  HH:MM:SS].

[In contrast, log files are set to UTC time zone.]

Severity Shows the classification for messages.

Module Shows the software module [as information for the developers].

Message Contains the contents and main information of the status message.

Context-Menu

§ Right Mouse Click - Perform a click with your right mouse button on an entry.
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Clear Log Messages Removes all logged items from the list.

Show Log File

Directory...

Opens the folder on your computer that holds saved log files. 

[You can change the directory in the options »Logging]

Copy Cell To

Clipboard

Copies the currently selected cell [that is, single information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + C]

Copy Rows To

Clipboard

Copies the currently selected line or lines [that is, all text and information] into the

clipboard/temporary memory.

[Keyboard shortcut: Ctrl + Shift + C]

Export List... Saves the entire, currently shown list/view/table as a preformatted text file.

Search

§ Search - Enter any text in order to search all items in the list.

- Any device/line that includes the search term will be shown. All others are temporarily filtered out.

- Terms can be case-insensitive. You don't have to use capital letters.

- Feel free to use terms that are incomplete. For example, mad will include results for MADRIX.

- You may specify certain columns by using a colon [:].

- For example: mess:IP shows all lines that include IP device information by referencing the column

Message, for example.
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Options

A new log file is created with each software start.

In addition, you can set up further settings for the Log in the Options.

Learn more »Logging 

Customization

MADRIX HARDWARE MANAGER allows you to choose which columns are presented in this view. You can decide which

columns are hidden or shown.

§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of the list.

Shown - A checkmark means that columns are shown.

Hidden - No checkmark means that columns are hidden.

Timestamp Shows or hides the Timestamp column.

Severity Shows or hides the Severity column.
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Module Shows or hides the Module column.

Thread Shows or hides the Thread column.

Message Shows or hides the Message column.
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3.8 User Interface

This topic includes:

§ Introduction

§ Restore Default Window Layout

§ Themes

§ Working With Lists

§ Showing Or Hiding Views

§ Re-Arranging The Layout

Introduction

The user interface of the software can be customized.

Restore Default Window Layout

§ Menu View > Restore Default Window Layout - Applies the default settings for the graphical user

interface, including sizes and shown columns. 

As such, it resets any changes you made to the software window.

Themes

You can change the general appearance of the software.

§ Menu Themes > Light - Activates the user interface theme that is light in color.

§ Menu Themes > Dark - Activates the user interface theme that is darker in color.

§ Learn more »Menu 
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Light Theme Dark Theme

Working With Lists

Overview

MADRIX HARDWARE MANAGER mainly presents information in lists.

There are numerous options to adjust the views and the information presented to you.

Show Or Hide Columns

MADRIX HARDWARE MANAGER allows you to choose which columns are presented in the Devices view. You can decide

which columns are hidden or shown.
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§ Right Mouse Click - Perform a click with your right mouse button anywhere on the header of a list.

Show Column - A checkmark means that this particular column is shown.

Hide Column - No checkmark means that this particular column is hidden.

Sorting

You can easily adjust how items are sorted in lists.

Click on a column header in order to sort the entire list accordingly. 

Ascending Order - An up-arrow means that items are shown in ascending order.

Descending Order - A down-arrow means that items are shown in descending

order.
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Re-Arranging Columns

You can easily change the order of columns in lists.

§ Left Mouse Click + Hold + Drag & Drop - Perform a click with your left mouse button on a column

header, continue to hold it, and move the header to its new position on the list. Release the mouse button in

order to let the column snap into its place.

Automatically Resizing Columns

§ Move your mouse pointer to the end of a header cell of a table/list. 

§ The mouse pointer will change to represent two arrows.

§ Perform a Left Mouse Double-Click and the size of the column will adjust automatically to the length of the

longest entry.

Showing Or Hiding Views

Undock View - Allows you to quickly undock a single view [in order to use it as separate window or to

rearrange the layout of the user interface].

Close View - Allows you to quickly close a single view.

 

Re-Arranging The Layout
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You can rearrange views of the software.

1] Show a view, such as Log.

2] Perform a left mouse click + hold on the top bar of the view window you wish to relocate and drag the

view into its designated place. 

3] The view will snap into its new location.

4] A variety of locations is available to position views anew [left, top, right, bottom]. 

5] Use the drag-handle that is positioned between views to increase or decrease the width of views.

 

6] When not docked, single views can also be shown on a different monitor, for example.
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4 Extra Tools

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Separate tools may be provided with the software.

Topics Of This Chapter

§ Quick Support
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4.1 Quick Support

This topic includes:

§ Introduction

§ Instructions

§ Where To Find

Introduction

The MADRIX HARDWARE MANAGER Quick Support is provided along with this software.
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Instructions

§ When contacting the MADRIX Support Team, you may be asked by them to use the MADRIX HARDWARE

MANAGER Quick Support tool for technical support assistance on your computer.

§ Click on the shortcut in order to launch it [see below where to find it].

§ After the tool has been launched, wait until Ready to connect (secure connection) is shown.

§ The MADRIX Support Team will then be able to connect to your computer.

§ A new message window opens that reads: 'MADRIX would like to view and control your desktop.

Would you like to allow that?'

Please confirm by clicking Allow

§ The MADRIX Support Team will now be connected.

Where To Find

MADRIX HARDWARE MANAGER Quick Support is included in the MADRIX HARDWARE MANAGER Installer. After

installing the software, you can find the link to MADRIX HARDWARE MANAGER Quick Support in the Windows Start

menu:

§ In Windows 10, go to Start > MADRIX HARDWARE MANAGER > MADRIX HARDWARE MANAGER

Quick Support

The original, executable program can be found in the software's installation directory: 
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§ C:\Program Files\MadrixHardwareManager
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5 Legal

This topic includes:

§ Introduction

§ Topics Of This Chapter

Introduction

Legal includes all legal documents and information, including copyright and more.

Topics Of This Chapter

§ End-User License Agreement [EULA]

§ OpenSSL & SSLeay [Legal Information]

§ Qt [Legal Information]

§ Sourcetree [Legal Information]

§ Imprint And Copyright
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5.1 End-User License Agreement [EULA]

This topic includes:

§ Overview

§ Copy Of License

Overview

A copy of the following license is available as text file in the installation directory, for example C:\Program

Files\MadrixHardwareManager\

Copy Of License

END-USER LICENSE AGREEMENT FOR INOAGE SOFTWARE

MADRIX HARDWARE MANAGER Software License Agreement

Last Update: 09/2021

This end-user license agreement ('EULA') is a legal agreement between you and the company inoage

GmbH ('inoage'). 

This EULA governs your use of the MADRIX HARDWARE MANAGER Software ('software') but not its

acquisition, and thereby does not refer to your purchase contract.

IMPORTANT NOTE

PLEASE CAREFULLY AND THOROUGHLY READ THIS LICENSE AGREEMENT. MAKE SURE THAT YOU FULLY UNDERSTAND

ALL INFORMATION. BY CONTINUING THE INSTALLATION AND/OR BY USING THIS SOFTWARE, YOU CONFIRM THAT

YOU HAVE READ THE LICENSE AGREEMENT, ACCEPT ALL OF ITS TERMS AND CONDITIONS WITHOUT RESERVATIONS,

AND AGREE THAT YOU THUS BECOME LEGALLY BOUND TO THE TERMS OF THIS LICENSE AGREEMENT.

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS, PLEASE STOP THE INSTALLATION PROCESS. YOU CAN DO

SO BY CLICKING 'CANCEL'. 

IF YOU DO NOT ACCEPT THESE TERMS AND CONDITIONS BUT HAVE ALREADY INSTALLED THE SOFTWARE, PLEASE

IMMEDIATELY REMOVE, DELETE, AND DESTROY ALL COPIES OF IT AND ASSOCIATED DOCUMENTS AND DATA.
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VALIDITY

This license agreement is only valid for the currently used software version as indicated by the

software under the menu 'Help > About... > Version'. This license does not automatically extend

to any software updates that may be available in the future.

WARRANTY DISCLAIMER AND LIMITATION OF LIABILITY

The software or any part thereof is licensed 'as is' and without warranty of any kind.

inoage does not grant guarantee on validity for a particular reason, the marketability, or other

properties of the product. There is no way to assert a claim to inoage, neither in the legal way

nor in other ways. inoage is not responsible for damages, including all disadvantages that are

not just limited to the loss of sales, but that are caused due to the use of the product, due to

the loss of serviceability of the product, due to misuse, happenings, circumstances, or actions

that inoage does not have influence on, no matter if the damages as well as consequential damages

are direct or indirect, incidental or consequential; whether they are special damages or others,

nor if the damage is caused by the owner of the warranty or a third person.

Any and all such warranties are disclaimed likewise by contributors, licensors, and third parties

of third-party software, SDKs, and drivers that enable specific software features.

You accept that you are using the software at your own and sole risk. This also refers to the

level of satisfaction regarding its quality, features, and performance. 

USAGE RIGHTS

inoage conceded you the limited, non-exclusive right to use this software, and the associated

documents and files, in accordance with the terms of this license agreement. The software is

'used' on a computer or similar hardware system when it has been loaded or installed on a storage

device of the computer, including but not limited to hard disks, SSDs, non-volatile memory, or

similar, or loaded into memory in general. The software usage rights are thus not sold but

conceded under license.

Full ownership over the software and all rights that are not expressly granted to you by this

license remain with inoage.

SOFTWARE LICENSE AND AUTHORIZED USE

This software is free to use and does not require you to purchase a software license in order to

fully unlock the software's features. However, the software's intended purpose is the management

and configuration of MADRIX hardware products, which are available for purchase separately.
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You are authorized to use the software extensively and according to its features as described

above especially, but not limited to, for commercial purposes and production work.

RESTRICTIONS

You are not allowed to or allowed to attempt to and agree to not enable others to:

(a) add to, alter, decode, decompile, delete from, disassemble, decrypt, edit, modify, recompile,

rename, reverse-engineer the whole software or any part thereof (except as expressly permitted by

this license regarding open-source components), otherwise attempt to derive or gain access to the

source code, reduce the compiled binary assembly to human-readable form, or create derivative

works from the software or any part thereof;

(b) alter, delete, remove, or obscure any identification of the software, copyright note, or any

other notes relating to the property restrictions of the software or any part thereof;

(c) bypass, circumvent, overcome, or work around any technical or non-technical means,

restrictions, or limitations that are put in place in or together with the software;

(d) copy the whole or parts of the software's documentation.

PERMISSIONS

(a) You are allowed to install, run, and use the software within the limits of this license.

TERMINATION

This license is effective until terminated. You can terminate it at any time by removing,

deleting, and destroying all software files and associated copies. This license will also

automatically terminate if you fail to comply with one or more of its clauses. In this case, you

must destroy the software and all the associated data, documents, and copies immediately.

COPYRIGHT AND PROPERTY

This software and all of its source codes are the exclusive property of inoage, except where

otherwise noted, and are protected by the laws in force on the copyright and the intellectual

property. MADRIX is a registered trademark of inoage GmbH. All other company and product names

may be trademarks of their respective companies.

THIRD PARTIES

Third-party copyright information and legal notices are accessible or point to further

information under the menu 'Help > About...' or corresponding chapters in the software's user

manual.
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Certain third-party software, including features provided by the operating system, and/or SDKs

and drivers are required for specific software features. Please note that all of these tools may

be subject to their own, separate end-user license agreements or similar terms and conditions.

CONTACT

You may contact inoage using the following contact details:

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

E-mail: info@madrix.com

Web: https://www.madrix.com

ACCESS

This EULA will also directly be made available as a text file in the installation directory of

the software.

CONSENT

By clicking 'I Agree', you hereby confirm that you have read, consent to the described policies,

and accepted the license agreement as provided above.
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5.2 OpenSSL & SSLeay [Legal Information]

This topic includes:

§ Included Libraries

§ Copy Of License

Included Libraries

MADRIX HARDWARE MANAGER uses the following libraries:

§ libeay32.dll

§ ssleay32.dll

A copy of the following license is available as text file in the installation directory, for example C:\Program

Files\MadrixHardwareManager\

Copy Of License

  LICENSE ISSUES

  ==============

  The OpenSSL toolkit stays under a double license, i.e. both the conditions of

  the OpenSSL License and the original SSLeay license apply to the toolkit.

  See below for the actual license texts.

  OpenSSL License

  ---------------

/* ====================================================================

 * Copyright (c) 1998-2019 The OpenSSL Project.  All rights reserved.

 *

 * Redistribution and use in source and binary forms, with or without

 * modification, are permitted provided that the following conditions
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 * are met:

 *

 * 1. Redistributions of source code must retain the above copyright

 *    notice, this list of conditions and the following disclaimer.

 *

 * 2. Redistributions in binary form must reproduce the above copyright

 *    notice, this list of conditions and the following disclaimer in

 *    the documentation and/or other materials provided with the

 *    distribution.

 *

 * 3. All advertising materials mentioning features or use of this

 *    software must display the following acknowledgment:

 *    "This product includes software developed by the OpenSSL Project

 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

 *

 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to

 *    endorse or promote products derived from this software without

 *    prior written permission. For written permission, please contact

 *    openssl-core@openssl.org.

 *

 * 5. Products derived from this software may not be called "OpenSSL"

 *    nor may "OpenSSL" appear in their names without prior written

 *    permission of the OpenSSL Project.

 *

 * 6. Redistributions of any form whatsoever must retain the following

 *    acknowledgment:

 *    "This product includes software developed by the OpenSSL Project

 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"

 *

 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY

 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR

 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR

 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT

 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

 * OF THE POSSIBILITY OF SUCH DAMAGE.

 * ====================================================================

 *
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 * This product includes cryptographic software written by Eric Young

 * (eay@cryptsoft.com).  This product includes software written by Tim

 * Hudson (tjh@cryptsoft.com).

 *

 */

 Original SSLeay License

 -----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)

 * All rights reserved.

 *

 * This package is an SSL implementation written

 * by Eric Young (eay@cryptsoft.com).

 * The implementation was written so as to conform with Netscapes SSL.

 *

 * This library is free for commercial and non-commercial use as long as

 * the following conditions are aheared to.  The following conditions

 * apply to all code found in this distribution, be it the RC4, RSA,

 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation

 * included with this distribution is covered by the same copyright terms

 * except that the holder is Tim Hudson (tjh@cryptsoft.com).

 *

 * Copyright remains Eric Young's, and as such any Copyright notices in

 * the code are not to be removed.

 * If this package is used in a product, Eric Young should be given attribution

 * as the author of the parts of the library used.

 * This can be in the form of a textual message at program startup or

 * in documentation (online or textual) provided with the package.

 *

 * Redistribution and use in source and binary forms, with or without

 * modification, are permitted provided that the following conditions

 * are met:

 * 1. Redistributions of source code must retain the copyright

 *    notice, this list of conditions and the following disclaimer.

 * 2. Redistributions in binary form must reproduce the above copyright

 *    notice, this list of conditions and the following disclaimer in the

 *    documentation and/or other materials provided with the distribution.

 * 3. All advertising materials mentioning features or use of this software

 *    must display the following acknowledgement:

 *    "This product includes cryptographic software written by

 *     Eric Young (eay@cryptsoft.com)"

 *    The word 'cryptographic' can be left out if the rouines from the library
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 *    being used are not cryptographic related :-).

 * 4. If you include any Windows specific code (or a derivative thereof) from

 *    the apps directory (application code) you must include an acknowledgement:

 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"

 *

 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND

 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE

 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE

 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE

 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL

 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS

 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT

 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY

 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF

 * SUCH DAMAGE.

 *

 * The licence and distribution terms for any publically available version or

 * derivative of this code cannot be changed.  i.e. this code cannot simply be

 * copied and put under another distribution licence

 * [including the GNU Public Licence.]

 */
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5.3 Qt [Legal Information]

This topic includes:

§ Included Libraries

§ Copy Of License

Included Libraries

MADRIX HARDWARE MANAGER uses the following libraries of the Qt development framework. 

The libraries and their use are covered by GNU LGPL Version 3.

§ Qt5Core.dll

§ Qt5Gui.dll

§ Qt5Network.dll

§ Qt5Svg.dll

§ Qt5Widgets.dll

§ Qt5Xml.dll

§ qgenericbearer.dll [Qt Plugin DLL]

§ qsvgicon.dll [Qt Plugin DLL]

§ qgif.dll [Qt Plugin DLL]

§ qicns.dll [Qt Plugin DLL]

§ qico.dll [Qt Plugin DLL]

§ qjpeg.dll [Qt Plugin DLL]

§ qsvg.dll [Qt Plugin DLL]

§ qtga.dll [Qt Plugin DLL]

§ qtiff.dll [Qt Plugin DLL]

§ qwbmp.dll [Qt Plugin DLL]

§ qwebp.dll [Qt Plugin DLL]
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§ qdirect2d.dll [Qt Plugin DLL]

§ qminimal.dll [Qt Plugin DLL]

§ qoffscreen.dll [Qt Plugin DLL]

§ qwindows.dll [Qt Plugin DLL]

The complete, corresponding, and machine-readable source code of these files, including the license text, is available:

§ On the MADRIX Software USB flash drive, in the subfolder ThirdParty. For example, D:\ThirdParty

§ Online at https://www.madrix.com/support/download/

A copy of the following license is available as text file in the installation directory, for example C:\Program

Files\MadrixHardwareManager\

Copy Of License

                   GNU LESSER GENERAL PUBLIC LICENSE

                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <https://fsf.org/>

 Everyone is permitted to copy and distribute verbatim copies

 of this license document, but changing it is not allowed.

  This version of the GNU Lesser General Public License incorporates

the terms and conditions of version 3 of the GNU General Public

License, supplemented by the additional permissions listed below.

  0. Additional Definitions.

  As used herein, "this License" refers to version 3 of the GNU Lesser

General Public License, and the "GNU GPL" refers to version 3 of the GNU

General Public License.

  "The Library" refers to a covered work governed by this License,

other than an Application or a Combined Work as defined below.
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  An "Application" is any work that makes use of an interface provided

by the Library, but which is not otherwise based on the Library.

Defining a subclass of a class defined by the Library is deemed a mode

of using an interface provided by the Library.

  A "Combined Work" is a work produced by combining or linking an

Application with the Library.  The particular version of the Library

with which the Combined Work was made is also called the "Linked

Version".

  The "Minimal Corresponding Source" for a Combined Work means the

Corresponding Source for the Combined Work, excluding any source code

for portions of the Combined Work that, considered in isolation, are

based on the Application, and not on the Linked Version.

  The "Corresponding Application Code" for a Combined Work means the

object code and/or source code for the Application, including any data

and utility programs needed for reproducing the Combined Work from the

Application, but excluding the System Libraries of the Combined Work.

  1. Exception to Section 3 of the GNU GPL.

  You may convey a covered work under sections 3 and 4 of this License

without being bound by section 3 of the GNU GPL.

  2. Conveying Modified Versions.

  If you modify a copy of the Library, and, in your modifications, a

facility refers to a function or data to be supplied by an Application

that uses the facility (other than as an argument passed when the

facility is invoked), then you may convey a copy of the modified

version:

   a) under this License, provided that you make a good faith effort to

   ensure that, in the event an Application does not supply the

   function or data, the facility still operates, and performs

   whatever part of its purpose remains meaningful, or

   b) under the GNU GPL, with none of the additional permissions of

   this License applicable to that copy.

  3. Object Code Incorporating Material from Library Header Files.
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  The object code form of an Application may incorporate material from

a header file that is part of the Library.  You may convey such object

code under terms of your choice, provided that, if the incorporated

material is not limited to numerical parameters, data structure

layouts and accessors, or small macros, inline functions and templates

(ten or fewer lines in length), you do both of the following:

   a) Give prominent notice with each copy of the object code that the

   Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the object code with a copy of the GNU GPL and this license

   document.

  4. Combined Works.

  You may convey a Combined Work under terms of your choice that,

taken together, effectively do not restrict modification of the

portions of the Library contained in the Combined Work and reverse

engineering for debugging such modifications, if you also do each of

the following:

   a) Give prominent notice with each copy of the Combined Work that

   the Library is used in it and that the Library and its use are

   covered by this License.

   b) Accompany the Combined Work with a copy of the GNU GPL and this license

   document.

   c) For a Combined Work that displays copyright notices during

   execution, include the copyright notice for the Library among

   these notices, as well as a reference directing the user to the

   copies of the GNU GPL and this license document.

   d) Do one of the following:

       0) Convey the Minimal Corresponding Source under the terms of this

       License, and the Corresponding Application Code in a form

       suitable for, and under terms that permit, the user to

       recombine or relink the Application with a modified version of

       the Linked Version to produce a modified Combined Work, in the

       manner specified by section 6 of the GNU GPL for conveying

       Corresponding Source.
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       1) Use a suitable shared library mechanism for linking with the

       Library.  A suitable mechanism is one that (a) uses at run time

       a copy of the Library already present on the user's computer

       system, and (b) will operate properly with a modified version

       of the Library that is interface-compatible with the Linked

       Version.

   e) Provide Installation Information, but only if you would otherwise

   be required to provide such information under section 6 of the

   GNU GPL, and only to the extent that such information is

   necessary to install and execute a modified version of the

   Combined Work produced by recombining or relinking the

   Application with a modified version of the Linked Version. (If

   you use option 4d0, the Installation Information must accompany

   the Minimal Corresponding Source and Corresponding Application

   Code. If you use option 4d1, you must provide the Installation

   Information in the manner specified by section 6 of the GNU GPL

   for conveying Corresponding Source.)

  5. Combined Libraries.

  You may place library facilities that are a work based on the

Library side by side in a single library together with other library

facilities that are not Applications and are not covered by this

License, and convey such a combined library under terms of your

choice, if you do both of the following:

   a) Accompany the combined library with a copy of the same work based

   on the Library, uncombined with any other library facilities,

   conveyed under the terms of this License.

   b) Give prominent notice with the combined library that part of it

   is a work based on the Library, and explaining where to find the

   accompanying uncombined form of the same work.

  6. Revised Versions of the GNU Lesser General Public License.

  The Free Software Foundation may publish revised and/or new versions

of the GNU Lesser General Public License from time to time. Such new

versions will be similar in spirit to the present version, but may

differ in detail to address new problems or concerns.
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  Each version is given a distinguishing version number. If the

Library as you received it specifies that a certain numbered version

of the GNU Lesser General Public License "or any later version"

applies to it, you have the option of following the terms and

conditions either of that published version or of any later version

published by the Free Software Foundation. If the Library as you

received it does not specify a version number of the GNU Lesser

General Public License, you may choose any version of the GNU Lesser

General Public License ever published by the Free Software Foundation.

  If the Library as you received it specifies that a proxy can decide

whether future versions of the GNU Lesser General Public License shall

apply, that proxy's public statement of acceptance of any version is

permanent authorization for you to choose that version for the

Library.

5.4 Sourcetree [Legal Information]

This topic includes:

§ Overview

Overview

Powered by Atlassian.
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5.5 Imprint And Copyright

This topic includes:

§ Company And Address

§ Copyright

§ Credits

Company And Address

inoage GmbH

Wiener Straße 56

01219 Dresden

Germany

Managing Directors: Christian Hertel, Sebastian Pinzer, Sebastian Wissmann

Phone: +49 351 862 6869 0

Fax: +49 351 862 6869 68

Web:  »www.madrix.com

E-mail:  »info@madrix.com

Copyright

© Copyright (C) 2021 – 2023 inoage GmbH. All rights reserved.

MADRIX® is a registered trademark of inoage GmbH. 

http://www.madrix.com
mailto:info@madrix.com
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All other company names and/or product names are trademarks and/or entered trademarks of their respective

holders. The product might not always be conforming to the presentation, features, and performances. Technical data

can differ slightly, depending on the operating system and the chosen hardware. 

We withhold the option of changes without notification. inoage GmbH does not give any guaranty for function capability

for a certain purpose, the marked ability or other features of the product. No other guaranty claims, on legal or other

terms, can be enforced. 

Under no circumstances does inoage GmbH take on the responsibility for liabilities for faults for losses in sales volume

or profits, that occur through the usage of the product, through the serviceability, through abuse, happenings,

circumstances or actions, that we have no influence on. No matter if the damages were caused by the holder of the

product or a third person.

Credits

§ Art-Net™ - Designed by and Copyright Artistic Licence Holdings Ltd.

§ Other product and company names, terms, or [trade] marks are the property of their respective holders.


	MADRIX HARDWARE MANAGER User Manual
	Table Of Contents
	Introduction
	System Requirements
	Supported Devices
	Web Links

	Getting Started
	Installation Process
	Starting The Software
	About

	Using The Software
	Menu
	Devices [View]
	Firmware Files [View]
	External Storage [View]
	Updating Firmwares
	Options
	Log
	User Interface

	Extra Tools
	Quick Support

	Legal
	End-User License Agreement [EULA]
	OpenSSL & SSLeay [Legal Information]
	Qt [Legal Information]
	Sourcetree [Legal Information]
	Imprint And Copyright


